SIMATIC PCS 7 with PROFINET –
Typical Architectures and Engineering
SIMATIC PCS 7 V8.x
Warranty and liability

Note

The Application Examples are not binding and do not claim to be complete regarding the circuits shown, equipping and any eventuality. The Application Examples do not represent customer-specific solutions. They are only intended to provide support for typical applications. You are responsible for ensuring that the described products are used correctly. These Application Examples do not relieve you of the responsibility to use safe practices in application, installation, operation and maintenance. When using these Application Examples, you recognize that we cannot be made liable for any damage/claims beyond the liability clause described. We reserve the right to make changes to these Application Examples at any time without prior notice.

If there are any deviations between the recommendations provided in these Application Examples and other Siemens publications – e.g. Catalogs – the contents of the other documents have priority.

We do not accept any liability for the information contained in this document. Any claims against us – based on whatever legal reason – resulting from the use of the examples, information, programs, engineering and performance data etc., described in this Application Example shall be excluded. Such an exclusion shall not apply in the case of mandatory liability, e.g. under the German Product Liability Act (“Produkthaftungsgesetz”), in case of intent, gross negligence, or injury of life, body or health, guarantee for the quality of a product, fraudulent concealment of a deficiency or breach of a condition which goes to the root of the contract (“wesentliche Vertragspflichten”). The damages for a breach of a substantial contractual obligation are, however, limited to the foreseeable damage, typical for the type of contract, except in the event of intent or gross negligence or injury to life, body or health. The above provisions do not imply a change of the burden of proof to your detriment.

Any form of duplication or distribution of these Application Examples or excerpts hereof is prohibited without the expressed consent of the Siemens AG.

Security information

Siemens provides products and solutions with industrial security functions that support the secure operation of plants, systems, machines and networks. In order to protect plants, systems, machines and networks against cyber threats, it is necessary to implement – and continuously maintain – a holistic, state-of-the-art industrial security concept. Siemens’ products and solutions only form one element of such a concept.

Customer is responsible to prevent unauthorized access to its plants, systems, machines and networks. Systems, machines and components should only be connected to the enterprise network or the internet if and to the extent necessary and with appropriate security measures (e.g. use of firewalls and network segmentation) in place.

Additionally, Siemens’ guidance on appropriate security measures should be taken into account. For more information about industrial security, please visit http://www.siemens.com/industrialsecurity.

Siemens’ products and solutions undergo continuous development to make them more secure. Siemens strongly recommends to apply product updates as soon as available and to always use the latest product versions. Use of product versions that are no longer supported, and failure to apply latest updates may increase customer’s exposure to cyber threats.

To stay informed about product updates, subscribe to the Siemens Industrial Security RSS Feed under http://www.siemens.com/industrialsecurity.
Preface

Objective of the document

This description will lead you through the integration of PROFINET into the process levels and the field level of SIMATIC PCS 7. Various topologies will be carried out and explained, the focus of the description being on the integration of PROFINET as a field bus.

Core contents

The following main points will be discussed in this application example:

- Architecture
- Selection of components
- System limits or constraints
- Depiction of the network architecture with the topology editor.
- Configuring cyclic communication
- Diagnostic possibilities

Validity

This application example refers to the implementation with PCS 7 V8.0 SP1 and newer versions with the modules released for this version. The example is applicable to PCS 7 V8.1 and PCS 7 V8.2 without restrictions.

NOTE

PROFINET has been supported since the PCS 7 version 8.0 Upd. 1. With PCS 7 V8.0 SP1, the HART communication via PROFINET has been released.
## Table of contents

Warranty and liability ........................................................................................................... 2

Preface ................................................................................................................................. 3

1 Task and Solution ............................................................................................................... 5
  1.1 Task ........................................................................................................................... 5
  1.2 Solution ...................................................................................................................... 5
  1.3 Hardware and software components ....................................................................... 7

2 Basics ................................................................................................................................. 9
  2.1 Terminology PROFIBUS and PROFINET ............................................................. 9
  2.2 Media redundancy ................................................................................................. 9
  2.2.1 Redundancy procedure HRP and MRP .......................................................... 10
  2.2.2 PROFINET process level with redundancy procedure MRP ..................... 11
  2.3 System redundancy ............................................................................................... 12
  2.4 Typical PCS 7 architectures .................................................................................. 13
  2.4.1 System level ....................................................................................................... 13
  2.4.2 Process level ....................................................................................................... 13
  2.5 PROFINET communication ................................................................................... 17
  2.5.1 Real-time capability ......................................................................................... 17
  2.5.2 Field bus integration ....................................................................................... 18
  2.6 Virtual Local Area Network (VLAN) .................................................................... 19

3 Installation and Assembly .............................................................................................. 20
  3.1 Software ................................................................................................................... 20
  3.2 Hardware assembly .................................................................................................. 20

4 Configuration, Project Engineering and Parameter Assignment ............................... 21
  4.1 Configuration of nodes (address and name) ......................................................... 21
  4.2 PROFINET configuration ...................................................................................... 28
  4.3 MRP configuration ................................................................................................ 30
  4.4 Diagnostic possibilities ......................................................................................... 33
  4.4.1 Topology Editor .................................................................................................. 33
  4.4.2 PROFINET diagnostics and maintenance ...................................................... 34
  4.4.3 Plant Asset Management ................................................................................ 34

5 Operating the Application ............................................................................................. 35
  5.1 Scenario A - configuration and diagnostics of PROFINET connections with the topology editor ................................................................. 36
  5.2 Scenario B - Configuration of the HART communication ................................ 39
  5.3 Scenario C - Configuration of a PROFIBUS PA segment ................................... 42

6 Further notes, tips and tricks, etc. .................................................................................. 45
  6.1 Comparison of PROFIBUS, PROFINET and Ethernet in the office environment ................................................................. 45

7 Related literature ............................................................................................................ 47

8 History ............................................................................................................................. 47
1 Task and Solution

1.1 Task

Its flexible architecture and seamless integration into Totally Integrated Automation (TIA) from Siemens allows SIMATIC PCS 7 to be used in various applications and sectors. SIMATIC PCS 7 allows the implementation of requirements at all hierarchy levels of industrial automation, from the corporate management level through the control level to the field level.

Additional requirements to performance and the quantity framework in the field level push the integration of new technologies into PCS 7. The basis for such a technology is provided by the open Industrial Ethernet standard of the Profinet International (PI) Organization.

1.2 Solution

With the integration of PROFINET (PROcess FIeld NET) as field bus, SIMATIC PCS 7 supports a great number of technologies for the communication on the field level. The PROFINET, based in the international standards IEC 61158 and IEC 61784, combines the advantages of the open network standard Ethernet and the field bus system PROFIBUS. PROFINET can be used as the only field bus or in combination with the proven PROFIBUS DP for the communication between automation systems and process periphery.

This description gives you a practical procedure for planning and configuring PROFINET in the PCS 7 environment. This application example provides a quick introduction to the topic, gives you an overview of possible topologies and supports you with numerous step-by-step instructions (Getting Started character).

Overview

The figure below shows the most important components of the PROFINET solution.

Figure 1-1
The automation task requires the following steps:

- Configuring distributed IO and field devices in HW Config
- Configuration of field devices in SIMATIC PDM
- Checking and setting the bus parameters

This description guides you through the subject PCS 7 with PROFINET and includes guidance on the following focal points:

- Basic knowledge such as architecture, PROFINET terminology etc. (Media redundancy and System redundancy)
- Selection of suitable components (released components)
- System limits or constraints
- Parameterizing and configuring the workbench in PCS 7

Delimitation

This application example does not include a description of the following:

- Basic SIMATIC PCS 7 configuration
- Working and configuration with SIMATIC PDM
- Process-specific device configuration in SIMATIC PDM

Basic knowledge of these topics is assumed.

Advantages

The solution presented in this document offers the following advantages:

- Quick development of PROFINET know-how
- Description of typical scenarios, e.g. complete configuration, commissioning and device integration in PROFINET segments
- This reduces the planning and configuration overhead.
1.3 Hardware and software components

The application example was set up with the following components:

Hardware components

<table>
<thead>
<tr>
<th>Hardware components</th>
<th>Order number</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU 410-5H</td>
<td>6ES7 410-5HX08-0AB0</td>
</tr>
<tr>
<td>CP 443-1</td>
<td>6GK7 443-1EX30-0XE0 (V3.1)</td>
</tr>
<tr>
<td>ET 200M (IM 153-4 PN HF)</td>
<td>6ES7 153-4BA00-0XB0 (V4.0)</td>
</tr>
<tr>
<td>AI8x0/4…20mA HART</td>
<td>6ES7 331-7TF01-0AB0</td>
</tr>
<tr>
<td>AO4x12Bit</td>
<td>6ES7 332-5HD01-0AB0</td>
</tr>
<tr>
<td>DI16xDC24</td>
<td>6ES7 321-1BH02-0AA0</td>
</tr>
<tr>
<td>DO16xDC24</td>
<td>6ES7 322-1BH01-0AA0</td>
</tr>
<tr>
<td>F-DO10xDC24</td>
<td>6ES7 326-2BF10-0AB0</td>
</tr>
<tr>
<td>F-AI6x0/4…20mA HART</td>
<td>6ES7 336-4GE00-0AB0</td>
</tr>
<tr>
<td>SITRANS TH300</td>
<td>7NG3212-0NN00</td>
</tr>
<tr>
<td>SCALANCE X208-2</td>
<td>6GK5 208-0BA10-2AA3 (V4.5)</td>
</tr>
<tr>
<td>IE/PB Link PN IO</td>
<td>6GK1411-5AB00</td>
</tr>
<tr>
<td>PA coupler</td>
<td>6ES7 157-0AC83-0XA0</td>
</tr>
<tr>
<td>SITRANS P DSIII</td>
<td>7MF4432-1DA00-1AB6-Z</td>
</tr>
</tbody>
</table>

NOTE

Please find the list of the PROFINET modules released for PCS 7 using “SIMATIC Process Control System PCS 7 Released Modules (V8.2)” via following link: https://support.industry.siemens.com/cs/ww/en/view/109736547. The released modules of further versions can be obtained by changing the edition (dropdown menu) on the entry page.

Table 1-2 – Engineering system

<table>
<thead>
<tr>
<th>Engineering system</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>SIMATIC PCS 7 ES/OS IPC547D W7</td>
<td>Engineering station with PCS 7 V8.0 SP1/SP2</td>
</tr>
<tr>
<td>SIMATIC PCS 7 ES/OS IPC547E</td>
<td>Engineering station with PCS 7 V8.1</td>
</tr>
<tr>
<td>SIMATIC PCS 7 ES/OS IPC547E</td>
<td>Engineering station with PCS 7 V8.2</td>
</tr>
</tbody>
</table>

NOTE

When using different hardware, please observe the minimum requirements for installing the software components. The minimum requirements can be found in the PCS 7 readme file.
### Standard software components

Table 1-3 – Software components

<table>
<thead>
<tr>
<th>Component</th>
<th>Order number</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>SIMATIC PCS 7 V8.0</td>
<td>Part of Industrial PC</td>
<td></td>
</tr>
<tr>
<td>SIMATIC PCS 7 V8.1</td>
<td>Part of Industrial PC</td>
<td></td>
</tr>
<tr>
<td>SIMATIC PDM PCS 7 V8.1</td>
<td>6ES7 658-3LD18-0YA5</td>
<td>(Optional) For the configuration of field devices (100 tag)</td>
</tr>
<tr>
<td>SIMATIC PDM PCS 7 V8.2</td>
<td>6ES7658-3LD28-0YA5</td>
<td>(Optional) For the configuration of field devices (100 tag)</td>
</tr>
<tr>
<td>SIMATIC PDM PCS 7 V9.0</td>
<td>6ES7658-3LD58-0YA5</td>
<td>(Optional) For the configuration of field devices (100 tag)</td>
</tr>
</tbody>
</table>
2 Basics

2.1 Terminology PROFIBUS and PROFINET

PROFINET differentiates between two different message applications:

- PROFINET CBA (Component Based Automation), not supported in PCS 7
  Communication across manufacturer borders (control level) of intelligent
  automation components and system parts
- PROFINET IO, supported since PCS 7 V8.0 Upd.1
  Cyclic communication (IO data) from the controller with distributed field devices

While the function models of PROFIBUS DP and PROFINET are similar, a different terminology is used for the individual technologies. These expressions are compared in the table below.

<table>
<thead>
<tr>
<th></th>
<th>PROFIBUS</th>
<th>PROFINET</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication</td>
<td>Master slave procedure (Token-Passing)</td>
<td>Real-time provider-consumer model</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(Switched-Ethernet)</td>
</tr>
<tr>
<td>Automation System</td>
<td>Master class 1</td>
<td>IO controller</td>
</tr>
<tr>
<td>Field device</td>
<td>Slave</td>
<td>IO device</td>
</tr>
<tr>
<td>PG/PC</td>
<td>Master class 2</td>
<td>IO supervisor</td>
</tr>
<tr>
<td>Device description</td>
<td>GSD (ASCII)</td>
<td>GSDML (XML)</td>
</tr>
<tr>
<td>Address assignment</td>
<td>PROFIBUS DP address</td>
<td>IO device name</td>
</tr>
<tr>
<td>Message size</td>
<td>244 Bytes</td>
<td>1440 Bytes</td>
</tr>
<tr>
<td>Subscribers</td>
<td>max. 125</td>
<td>max. 250</td>
</tr>
<tr>
<td>Transmission speed</td>
<td>max. 12 MBit/s</td>
<td>10/100 Mbit/s full duplex</td>
</tr>
<tr>
<td>Cycle time</td>
<td>min. 300 µs</td>
<td>min. 31.25 µs</td>
</tr>
</tbody>
</table>

NOTE

For more detailed information on the comparison of PROFIBUS, PROFINET and Ethernet, please see Chapter 6 "Further notes, tips and tricks, etc.".

2.2 Media redundancy

The availability of the IO devices in an IO controller is increased by ring topology with media redundancy. If the transmission path in a ring is interrupted in one place, for example due to a disconnection of the ring line or because a node fails, then the redundancy manager immediately activates the alternative communication path.
2.2.1 Redundancy procedure HRP and MRP

For building up a media redundancy with SIMATIC NET components for ring topologies, the following procedures are available:

<table>
<thead>
<tr>
<th></th>
<th>HRP (Highspeed Redundancy Protocol)</th>
<th>MRP (Media Redundancy Protocol)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max. reconfiguration time</td>
<td>300 ms</td>
<td>200 ms</td>
</tr>
<tr>
<td>Automatic ring configuration</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Maximum number of nodes in the ring</td>
<td></td>
<td>50</td>
</tr>
<tr>
<td>Web Based Management</td>
<td>Yes for configuration</td>
<td>Yes (optional to STEP 7 configuration)</td>
</tr>
<tr>
<td>CLI (Command Line Interface)</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>SNMP (Simple Network Management Protocol)</td>
<td>Yes for diagnosis</td>
<td>Yes (Additional to system diagnosis)</td>
</tr>
<tr>
<td>STEP 7 configuration</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Source</td>
<td>SIMENS AG</td>
<td>Profibus&amp;Profinet International (PI) Organization</td>
</tr>
</tbody>
</table>

**NOTE**

For setting up a ring redundancy with HRP or MRP, the network components must support the respective procedure. A combination of PROFINET and HRP ring in the process level is not released.

Due to the STEP 7 configuration and system diagnosis possibilities, the procedures for the respective levels are recommended.

- System level: HRP -> Configuration via the web interface of the switches
- Process level: MRP -> Configuration in STEP 7 and system diagnosis

Figure 2-1
2.2.2 PROFINET process level with redundancy procedure MRP

For creating an MRP ring, the ring nodes (switch, IO devices) must support the MRP (Media Redundancy Protocol).

The following limits must be observed:
- max. 50 nodes in the ring
- max. 200 ms reconfiguration time (for 50 nodes in the ring)

Figure 2-2

The following Industrial Ethernet switches support the MRP function:
- SCALANCE X-200 as of Firmware-Version V4.0
- SCALANCE X-200 IRT as of Firmware-Version V4.0
- SCALANCE X-300 as of Firmware-Version V3.0
- SCALANCE X-400 as of Firmware-Version V3.0

Advantages
- Increased flexibility
- Increased flexibility of the system (in case of a failure, the transmission direction of the telegram is changed)
- Additional diagnostic possibilities (topology editor)
2.3 System redundancy

The system redundancy (System Redundancy Protocol) is a mechanism for maintaining the PROFINET connection between the IO controller and the IO devices. It is characterized by a form of the PROFINET IO communication, in which every IO device builds up a communication link via the topologic network with one of the two IO controllers (active and backup CPU) of an AS Redundancy Station. In contrast to a unilateral connection of the IO device to only one IO controller, a failure of the CPU will not automatically lead to a failure of the linked IO device connections.

NOTE
For the system redundancy, the following components can be used:

- CPU 410-5H
- S7-400 H-CPU with ≥ FW V6.0
- ET 200M with ≥ FW V4.0

Figure 2-3 PROFINET with system redundancy

Advantages

- High-performance access
- Failure of one CPU is compensated by switching to others
- Not affected by broken wires (process level) or in case of an IO device failure

NOTICE
For configurations with redundant automation system processes all connected IO devices must support the system redundancy regardless of the connection path. If one IO device does not support the system redundancy, stopping an AS sub-system will lead to a failure of the IO devices.
2.4 Typical PCS 7 architectures

2.4.1 System level

PROFINET is basically designed for common use in system and process level. In order to meet the security aspects and the real-time requirements in process automation, both system and process level needs to be built up and integrated separately from each other. The known architectures involving Ethernet can be implemented in the system level.

NOTE An overview of SIMATIC PCS 7 architectures is described in the document “PCS 7 Standard Architectures” via the following link https://support.industry.siemens.com/cs/ww/en/view/32201963.

The following graphic shows a sample configuration for a redundant automation system.
Figure 2-4

2.4.2 Process level

In PCS 7 many different configurations can be implemented with PROFINET as the field bus (process level). The right configuration is to be selected depending on the size of plant and the number of nodes. The general topologies are presented below as well as their corresponding advantages and disadvantages relating to PCS 7

For the connection of the field level to the automation system (AS), the internal PROFINET interface (from CPU with FW V6.0) is to be preferred. As an alternative, the CP443-1EX30* can be used in combination with the standard CPU (414-3, 416-2, 416-3 and 417-4) with version V5.3.1 and higher.

NOTE As of PCS 7 V8.1 with CPU 410-5H FW V8.1 two PROFINET fieldbus segments can be realized by using the two PN/Ethernet interfaces of the CPU.
PROFINET configuration of a single automation system

A MRP ring or a tree structure can be used for a single configuration (comparable with the monomaster system for PROFIBUS topology) according to required reaction time and number of IO devices. The MRP ring is the most cost-effective solution since no additional components are needed. The IO device internal 2 port switches are used for the ring structure. In doing so, the IO device takes over the function of ring master.

With a single automation system all the basic structures are supported which include:

- **Line**: simplest structure, but more prone to failure, since a device failure causes an interruption in the line
- **Star**: implement an effective wiring with additional network components. The number of nodes is depending on the switch.
- **Ring**: robust configuration with up to 50 IO devices and a maximum reconfiguration time of 200ms (for 50 ring nodes in use)
- **Mixed configuration**: any theoretical structure and flexible extension possible, partly prone to failure and complex
  - A mixed configuration (ring/star) with an MRP ring provides the best possible reliability. The MRP ring is composed of an IP controller and the switches. The IO devices are to be connected to the switches.
  - The tree structure (a mixed configuration of line and star) with multi-channel switches (≥ 8 ports) enables short reaction times. Up to 250 IO devices and up to 62 switches connected in series, characterize this topology.
  - Depending on the requirements, the adequate ring, tree or ring/star configuration must be chosen.

Figure 2-5 – Single PROFINET configuration
PROFINET configuration of a fault-tolerant automation system

For the topology of a redundant configuration (can be compared with the redundant master system in the PROFIBUS topology), the requirement concerning the availability of the IO devices is decisive. If simple availability is sufficient (no redundant connection paths), the topologies of the single PROFINET configuration can be used. If the connection paths need to be redundant, we recommend a line topology with an IO controller each at the beginning and the end. In case of an error, the IO controllers of the H system can access all the remaining IO devices by means of the system redundancy via the Sync connection. The maximum number of IO devices of this line must not exceed 64 devices.

An RMP ring is possible, but does not have any advantage as compared to a line topology of the same structure.

NOTICE

For configurations with redundant automation system processes all connected IO devices must support the system redundancy regardless of the connection path. If one IO device does not support the system redundancy, stopping an AS sub-system will lead to a failure of the IO devices.

Figure 2-6 – Fault-tolerant automation system with PROFINET
Networking of different automation systems

With PROFINET the time and costs for the assembly of system parts for several AS (switchgear, for example) can be considerably reduced. By interconnecting all the IO controllers (can be compared with the multimaster system in the PROFIBUS topology, not released for PCS 7) with a higher-level ring, every IO controller can communicate with the IO devices assigned to it.

To avoid intersections and thus overloads or runtime delays during the PROFINET communication, the higher-level ring must be separated by a spur line. This spur line represents a "single point of failure" and should therefore be designed as short as possible.

This comprehensive connection can be used for singular and for highly available automation systems.

Due to the real time band width, it is not recommended to operate all the IO controllers and all the IO devices in the same ring.

The following figure shows a feasible configuration:

Figure 2-7 – Networked automation systems with PROFINET

<table>
<thead>
<tr>
<th>1. AS</th>
<th>2. AS</th>
<th>3. AS</th>
<th>Device integration</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Diagram" /></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

NOTE

Through the utilization of PCS 7 V8.1 / PCS V8.2 and CPU 410-5H FW V8.1 a PROFINET configuration with two PROFINET segments can be realized. E. g. the first segment can be used for switchgear (drives and circuit-breakers) and the second segment for all process devices.

1. AS (highly available automation system)
   - all devices of this AS must support the system redundancy
   - no COs admissible as IO controller
   - connection to the ring without redundancy
2. AS (single automation system)
   - MRP ring for reducing costs
   - expandable with external CPs as IO controllers (CPU 412..417) up to 128 IO devices per CP
2.5 PROFINET communication

2.5.1 Real-time capability

The real-time capability (Real Time/Isochronous Real Time) of PROFINET is implemented by a deterministic procedure. A transmission time (cycle time) for the transmission of the data is (cyclically) calculated on the basis of the configured data. This calculated time corresponds to the data exchange of the cyclic data (IO data such as process values) in a defined period of time. The acyclic data (TCP/IP-UPD/IP data such as engineering and diagnosis data) are distributed to the following cycles depending on the available bandwidth.

For the real-time communication the respective data are classified (real time classes), i.e. the higher prioritized data (cyclic data) are transmitted with priority in a reserved transmission band width.
In real-time communication, we differentiate between the following two performance levels:

- **Real-Time (RT):** transmission of prioritized data in a defined period of time (e.g. max 200ms)
- **Isochronous Real-Time (IRT), not released for PCS 7:** guaranteed transmission of the data in synchronized periods of time (e.g. with a transmission rate of 1000 µs, the IRT data are transmitted during the first 100 µs). IRT is used for motion control applications, but not for PCS 7.

**NOTE**

Please find more detailed information on the overview, structure, functions and IO engineering of PROFINET in the system manual “PROFINET System Description” via the following link [https://support.industry.siemens.com/cs/en/view/19292127](https://support.industry.siemens.com/cs/en/view/19292127).

### 2.5.2 Field bus integration

For the integration of further technologies, so-called proxies are used. At the PROFINET side, the proxy behaves like a PN device and at the PROFIBUS side like a PROFIBUS DP master (subsegment).

**Figure 2-9**

![PROFIBUS PA Proxy (IE/PB link PN IO)](image)

**NOTE**

The S7 routing functionality allows for a communication of a programming device via the IE/PB link PN IO to the lower-level PROFIBUS DP segment. Only compact devices are used as PROFINET DP nodes. These include flow meters with a PROFIBUS DP connection, PROFIBUS PA devices connected via DP/DA couplers etc.

So

- device configurations can be carried out
- the process values can be visualized by means of the OPC communication
2.6 Virtual Local Area Network (VLAN)

VLAN-capable switches provide an alternative and flexible way for connecting PROFINET/Ethernet devices over a network. VLAN (Virtual Local Area Network) refers to a method in which several logical or virtual networks are created within a physical network. There are two types of VLAN:

- Untagged (port-based) VLAN: The ports are assigned to VLANs, i.e. a switch can support two independent (logical) networks.
- Tagged VLAN: The Ethernet frame is also equipped with tags containing a VLAN ID, which connects them through a VLAN network address.

The figure below shows the structure of a simple architecture with VLAN.

Figure 2-10 Accessibility of the ES to the Process bus

NOTE
You can obtain further information on VLAN and on the configuring of VLAN segments with SCALANCE switches in the entry “How do you configure a Virtual Local Area Network (VLAN) in PCS 7?”, via the following link https://support.industry.siemens.com/cs/ww/en/view/66807297.
3 Installation and Assembly

For this installation example, a configuration consisting of an ES/OS single place system with a monomaster system (CPU 410-5H) and a lower-level PROFINET process bus is used. The various scenarios in chapter 5 “Operating the Application” are based on this configuration.

3.1 Software

Controller

For the configuration of the CPU 410-5H, PCS 7 V8.0 SP1 and HUP CPU 410-5H are required. The HUP CPU 410-5H is not part of the PCS 7 V8.0 SP1 installation pack and can be downloaded via the following link https://support.industry.siemens.com/cs/ww/en/view/68627630. In newer PCS 7 versions the hardware upgrade package is already included.

Configuration tool

From SIMATIC PDM V8.1 onwards, the communication type PROFINET is supported.

NOTE

In the SIMATIC PDM Readme you will find instructions for the installation, notes about the scope of functions and the HW/SW requirements.

3.2 Hardware assembly

Please ensure that the installation follows the “Automation System S7-400 Installation” manual and the system manual “Process Control System PCS 7 CPU 410-5H Process Automation”.

In addition, follow the installation guidelines, notes and recommendations of the manuals of the respective field devices and components. The following table lists the manuals and operating instructions used.

Table 3-1

<table>
<thead>
<tr>
<th>Component / device</th>
<th>Title</th>
<th>Entry ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>S7-400</td>
<td>Automation System S7-400 Installation</td>
<td>1117849</td>
</tr>
<tr>
<td>CPU 410-5H</td>
<td>SIMATIC PCS 7 process control system CPU 410-5H Process Automation</td>
<td>74736822</td>
</tr>
<tr>
<td>IE/PB Link PN-IO</td>
<td>PROFINET IO Getting Started: Collection</td>
<td>24842921</td>
</tr>
<tr>
<td>ET 200M</td>
<td>ET 200M Interface module IM 153-4 PN and IM 153-2 HF</td>
<td>46387818</td>
</tr>
<tr>
<td>AFD, AFDiS</td>
<td>Bus Links DP/PA Coupler, Active Field Distributors, DP/PA Link and Y Link</td>
<td>1142696</td>
</tr>
<tr>
<td>SCALANCE X-208</td>
<td>SIMATIC NET Industrial Ethernet Switches SCALANCE X-200 - Operating Instructions</td>
<td>102051962</td>
</tr>
</tbody>
</table>
4 Configuration, Project Engineering and Parameter Assignment

NOTICE
The configuring of the PROFINET nodes must be limited to the process/fieldbus in both the HW Config and in the topology editor. The configuring of cross-project PROFINET nodes results in no port diagnostics being available for these nodes.

4.1 Configuration of nodes (address and name)

This chapter describes the assignment of device names for the PROFINET nodes. For reducing complexity and possible sources for errors (IP address matching the subnet mask), the addressing is done with device names. This simple type of addressing can be compared to the way symbolic names are given to IO addresses. By using symbolic names, the usability during CFC programming was increased.

When starting up, the IO controller identifies all the IO devices by their configured device names and assigns them the IP address automatically.

For addressing an IO device, you have the following possibilities:

a. Assigning the address by the STEP 7 Primary Setup Tool (PST) or the web-based management (SCALANCE X components).

b. A memory card (MMC = Micro Memory Card or C plug) with the pre-configured device name (IO controller and IO device) and address (only IO controller).

c. Automatic assignment of the device names and IP addresses by neighbor relations (PROFINET functionality of the IO devices and the IO controller).

NOTE
For assigning the names, the Discovery and Configuration Protocol (DCP) is used, which is used for the assignment of the IP addresses to the device name. The IP addresses are generated by the configuration tool and downloaded to the IO controller. During system startup of the IO controller, the configured IP addresses are assigned automatically.
Configuration

Before the addressing of the individual components an address area and a device name structure have to be defined and integrated into the documentation.

NOTE
The bigger the plant, the more complex the planning becomes. The IP address and also the device name must only be used once (uniquely) in the system network. This facilitates changes in the network architecture, giving you more flexibility.

Please find more information on the addressing if you use the search terms “Subnetting” (creating specific IP address areas) and “IDNA” (defining device names according to DNA conventions) in the search engine.

In the following, the addressing procedure is described with the example of an IO controller (CPU 410-5H) and IO devices (ET 200M). The addresses are assigned from the ES.

1. Change to the HW Config of your multiproject.
2. Select the PROFINET IO interface (X5) and open the properties.
3. In the tab “General”, change the device name according to your plans. In the example, “AS01” has been entered for the first automation system.

4. Change into the interface properties by pressing the “Properties” button.
5. In the Properties window, enter a valid IP address (host) and subnet mask.
6. Create or assign a subnet to the interface.

NOTE
The subnet corresponds to the process field bus to which the IO device has been connected.
The PROFINET IO interfaces X5 and X8 must be configured for different subnets.

7. From the hardware catalog in the PROFINET IO tree, add the ET 200M (IM 153-4 PN HF 4.0) to the PROFINET segment.
8. Open the object properties of the ET 200M and change the device name according to your plans. In the example, “ET200M-nr01” has been entered for the first (nr01) ET 200M interface module.

**NOTE**
The system suggests a device number automatically (serves for the identification in the user program) and an IP address. The IP address can be changed with the "Ethernet..." button. Changing the address during system operation is possible with the AS Stop later on.

**NOTICE**
In the PROFINET IO system, up to 255 device numbers are supported by the driver generator.
Assigning the device name in HW Config

In the following, the device name configured in HW Config (ET200M-nr01) is transmitted to the device.

**NOTICE**

To transmit the device name to the ET 200M, the ES and the ET 200M must be in the same physical network. A routing via the AS (backplane bus) is impossible.

1. Go to the SIMATIC Manager and select “Options > Set PG/PC interface...”.
2. Select an Ethernet communication card in the tab “access path”. In this example, the “CP1613(RFC1006)” is used.
3. Connect the network cable (plant bus) of the CP443-1 (AS) to the internal PROFINET interface (AS).

**NOTE**

If your computer has a third Ethernet interface it can be connected with the process/field bus. In this case, this interface must be selected in the PG/PC interface for the assignment period.

4. Change to HW Config. Select the ET 200M and select “PLC > Ethernet > Assign Device Name...”.

![Diagram showing the connection between the ET200M-nr01, ES, and AS01 with network cables and PROFINET interface.]
5. Select the ET 200M module, either via the MAC address (printed on the module) or via the Node flashing test, and confirm with the button “Assign name”.

6. Select the ET 200M and select “PLC > Ethernet > Verify Device Name...”.

7. Restore the original configuration: Reconnect the network cable (system bus) with the CP443-1 (AS) or switch the PG/PC interface to “PC Internal (local)”.

**NOTE**  
If you have a list of all the IO devices with the corresponding MAC addresses and device names you can assign the names more effectively in the SIMATIC manager “PLC > Ethernet > Edit Ethernet Node ...”.
Assigning the device name and IP address with the Primary Setup Tool

In the following, the name and address are assigned with the PST (Primary Setup Tool) in the example of an IE/PB link. The computer must be connected to the respective network, in this example to the process/field bus. In addition the network card connected with this network must be selected in the “PB/PC interface” for the ISO transmission.

1. Open the PST and click on the symbol (magnifying glass) for searching the physical network segment for nodes with Ethernet interfaces. All the nodes that can be accessed via their MAC address are displayed in the device list with additional information (name, type, address, etc.).
2. In the device list, select the IE/PB link you want to change.
3. Click the "Assign Name" button to assign a new device name to the PROFINET IO device.
4. To change the IP address, select the interface and enter the new IP address and subnet mask in the right pane.

NOTE
If the PROFIBUS interface is selected, the transmission rate and the PROFIBUS DP address can be preset for the PROFIBUS DP segment.

5. The changes to the device are transferred from the menu command "Module > Load".

NOTE
At the following link you will find different versions of the Primary Setup Tool (PST), the corresponding Readme and the respective manuals:

NOTE
At the following link you will find the commissioning and diagnostics tool “PRONETA 2.3.0.26” for PROFINET with corresponding Readme and the respective manuals:
4.2 PROFINET configuration

The following instruction describes how to configure the PROFINET communication. In HW Config, a CPU 410-5 has already been configured and at least one PROFINET IO node is in the segment.

1. Change to the HW Config of your multiproject.
2. Select the PROFINET IO interface (X5) and open the properties.
3. Change to the “PROFINET” tab, adapt the parameters according to your needs and confirm the configuration with the “OK” button.

Legend

1. Send clock: The time between to intervals (IRT and RT communication) corresponds to the send interval for data exchange.
2. IO communication PROF. IO communication component for the PROFINET segment (process/field bus). At 100.0 %, the total capacity is reserved for the PROFINET data exchange. The complete communication component applies to the cyclic communication. For acyclic communication, the system reserves sufficient capacities. If the capacity for acyclic communication is not sufficient, the communication component can be reduced, taking the update time into consideration.
4. Select the PROFINET IO system in HW Config (process/field bus) and select "Object Properties" in the context menu. In "Object Properties", change to the tab "Update Time".

**NOTE**

On the basis of the available configuration (HW Config), the cyclic (configured) data, module properties and the communication component for PROFINET IO, STEP 7 automatically calculates an update time.

The update time can be adapted for a selected node with the "Edit..." button. The fixed update time has to be set to a value inferior to the quickest partial process image (TPA).

The watchdog time is the product of the parameters "Update time" and "Number of accepted update cycles with missing IO data". The watchdog time must be greater than 200ms to avoid module failure through redundancy switchover.

Please find more detailed information in the entry „What should you watch out for when parameterizing the watchdog time when a ring redundancy is established with the Media Redundancy Protocol?“ via the following link: [https://support.industry.siemens.com/cs/ww/en/view/46636225](https://support.industry.siemens.com/cs/ww/en/view/46636225).
4.3 MRP configuration

The media redundancy protocol (MRP) is used to compensate any network interruptions by redundant communication paths. In the following, the configuration of an MRP configuration is described. In HW Config, a CPU 410-5 has already been configured and a PROFINET segment has been created. The following system configuration is used for the description. Figure 4-1

1. Change to the HW Config of your multiproject and select the PROFINET IO system.
2. Select “Edit > PROFINET IO > Domain management”.

Figure 4-1
3. Go to the “MRP Domain” tab and press the “New” button (1) to create a new MRP domain and the “Edit...” button (2) to change the name of the domain.

4. In the “Nodes” section, select “Station / IO system” for a monomaster system or “Ring interconnections” for a redundant master system.

5. Select a station (AS) and assign the same domain and a role to every node with the “Edit...” button. Also activate “Diagnostic interrupts”.

Configuration:
- AS -> Role: “Manager”
- ET 200M -> Role: “Client”

NOTE
The option “Diagnostic interrupts” creates an alarm message when an active connection is interrupted.
6. Compile and download the modified configuration into the automation system.
7. Check the module diagnostic information of the nodes in the HW Config ONLINE view (Offline <-> ONLINE). Observe the diagnostic alarm if a connection or both connections between the automation system and the ET 200M is created.

NOTE

More detailed information are available in the following entry:

“What should you watch out for when parameterizing the watchdog time when a ring redundancy is established with the Media Redundancy Protocol?” via the following link: https://support.industry.siemens.com/cs/ww/en/view/46636225
4.4 Diagnostic possibilities

For a PROFINET segment based on ETHERNET, the various diagnostic possibilities with different information are available. These include:

- Diagnostics and maintenance via HW Config
- Diagnostics using the Web server of the IO controllers and IO devices
- Network simulation and diagnostics with the topology editor
- Asset Management via the PCS 7 maintenance station and SIMATIC PDM
- Network analysis tool, recording the complete data exchange and highlighting the various protocols in different colors.

NOTE

To receive diagnostic messages in the PCS 7 for all the devices, these devices must have been configured before. In addition to the IO devices, diagnostic messages of network components can be acquired in PCS 7. For this, the network components need to be configured with the topology editor.

4.4.1 Topology Editor

With the SIMATIC topology Editor, PROFINET IO systems can be configured topologically. For this, the interfaces and ports of the PROFINET IO nodes need to be interconnected.

The Topology editor has the following functions and properties:

- Display of all PROFINET devices and their ports in the project
- Configured cable length and cable type with calculated signal transit time for each port
- Interconnection data with location code of the individual PROFINET devices
- Diagnostic information of PROFINET devices for every single port
- Easy error detection through online/offline comparison of the node data
- Call diagnostics (module information) from the Graphic view
- Import the network topology

NOTE

You can create a documentation of your PROFINET IO network with the tool “Topology Reporter”. You can find further information via following link: https://support.industry.siemens.com/cs/ww/en/view/60035096
4.4.2 PROFINET diagnostics and maintenance

PROFINET offers a performant and consistent diagnostic concept, taking all the configured IO devices into account.

Device diagnostics are divided into three levels:

- Error on the device: Failure of a station
- Error on the slot: Defect of an individual module
- Error on a channel: for example, wire break

If an error occurs, the relevant IO device generates a diagnostic interrupt that is reported to the controller. This diagnostic information can be read out and evaluated by a programming unit in the diagnostics views.

NOTE Please find more detailed information about the diagnostic possibilities in the chapter “Diagnostics with PROFINET IO” in the “PROFINET System Description” via the following link:

4.4.3 Plant Asset Management

With the PCS 7 Maintenance Station, you get maintenance information (messages and requirements) about your system. The configuration of the functions is done in the ES and the observations are in a separate process image in the OS.

NOTE Please find more detailed information in the function manual “Process Control System PCS 7 Maintenance Station” via the following link:

The manuals of further versions can be obtained by changing the edition (dropdown menu) on the entry page.
5 Operating the Application

In this chapter, typical PROFINET scenarios are discussed and described. All the scenarios are created and configured on the basis of the components, node addresses and names from the Table 1-1 "Automation components" and Table 5-1 "Configuration list".

Table 5-1 Configuration list

<table>
<thead>
<tr>
<th>Device/node</th>
<th>Name</th>
<th>Communication</th>
<th>Address</th>
<th>Mac Address</th>
<th>No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>SITRANS P DS III</td>
<td>PT111</td>
<td>PROFIBUS PA</td>
<td>11</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SITRANS TH300</td>
<td>TT111</td>
<td>HART</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CPU 410-5H (Rack 0)</td>
<td>AS01</td>
<td>PROFINET PROFIBUS DP</td>
<td>172.20.10.1 2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CP-443 (AS01)</td>
<td>CP-a</td>
<td>PROFINET</td>
<td></td>
<td>08-00-06-01-01-01</td>
<td></td>
</tr>
<tr>
<td>ET 200M (IM 153-4 PN HF)</td>
<td>ET200M-nr01</td>
<td>PROFINET</td>
<td>172.20.0.10</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>SCALANCE X208</td>
<td>X208-nr01</td>
<td>PROFINET</td>
<td>172.30.0.20</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SCALANCE X208</td>
<td>X208-nr02</td>
<td>PROFINET</td>
<td>172.20.0.20</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>IE/PB Link PN IO</td>
<td>IEPB-nr01</td>
<td>PROFINET PROFIBUS DP</td>
<td>172.20.0.30 3</td>
<td></td>
<td>100</td>
</tr>
<tr>
<td>PA Coupler</td>
<td></td>
<td>PROFIBUS DP</td>
<td></td>
<td>4</td>
<td></td>
</tr>
<tr>
<td>IPC847C</td>
<td>ESOS-nr1</td>
<td>LAN 01 Process Bus LAN 02 Terminal Bus LAN 03 Plant Bus</td>
<td>172.20.0.100 172.40.0.100 172.30.0.100</td>
<td>08-00-06-01-01-00</td>
<td></td>
</tr>
</tbody>
</table>

Note

All the network nodes have the subnet mask 255.255.0.0, which corresponds to a host number of 65536 per subnet.

The plant and terminal buses are connected via a switch, but due to the IP addresses (172.30.x.x and 172.40.x.x), they belong to separate networks.

The device number (in the table listed as No.) is assigned during the configuration in HW Config and was integrated into the overview table subsequently.
5 Operating the Application

5.1 Scenario A - configuration and diagnostics of PROFINET connections with the topology editor

In this scenario, the following two configurations are set, and the focus is put on the network. The cable lengths used and the interconnected ports (interfaces of the nodes) must be known.

NOTICE
In the topology editor, only the PROFINET nodes necessary for the automation system are configured.

This procedure applies to an initial commissioning, since any switchover or changing of interfaces leads to a loss of communication in an existing AS OS connection. In HW Config, a CPU 410-5H has already been configured as described in chapter 4.1 “Configuration of nodes (address and name)”.

Procedure

1. Go to the SIMATIC Manager and select “Options > Set PG/PC interface...”.
2. In the tab “Access path”, select the Ethernet communication card with TCP/IP, which is connected to the field bus (process bus). In this example, the onboard network card was selected.

NOTE
If your computer does not have three Ethernet interfaces, the network switch can be switched over from the Plant Bus CP-442 to the internal Ethernet interface of the CPU.
3. Change to HW Config, select the PROFINET segment and select “PROFINET IO topology...” in the context menu.

4. In the topology editor, change to the “Graphic view” tab and connect the individual component interfaces according to the physical connection.

5. Confirm with the “Online” button and check the diagnostic information of the individual nodes. The following messages are displayed:

- (1) The diagnostic status query is not sent to the backplane bus of the automation system to the CP 443-1. The CP is not connected to the process/field bus, but to the plant bus.
- (2) No diagnostic status is available, since the IE/PB link does not completely support the ICMP call (exchange of information and field messages).

NOTE
If more than one Ethernet CPs are used and operated separately from the process/field bus, they are also displayed as not reachable.
6. In the following, we compare the online diagnostic messages in the tabs “Table view” and “Graphic view” when the following connections are interrupted:
   - (1) X208 and IE/PB link: The interruption of the IE/PB link is detected and the nodes are displayed as not reachable.
   - (2) AS and X208: The interruption of the ET 200M and of the respective interface of the switch are detected and displayed as not reachable.

![Table view](image1)
![Graphic view](image2)

7. Restore the original physical condition and confirm with the “OK” button.
8. Load the configuration in HW config into the automation system.

If device names have been used for all PROFINET nodes in the process/field bus level and the topology has been simulated in the topology editor, the device name and the IP address will be automatically assigned after the device exchange on the basis of the neighbor relation.

**NOTE**

For testing the automatic assignment, a PROFINET IO node can be reset to the default settings in a non-productive environment.
5 Operating the Application

5.2 Scenario B - Configuration of the HART communication

The following instruction describes how to integrate a HART device (0 to 20 mA with HART communication) into a PROFINET IO environment. For connecting a HART device, an ET 200M and HART-capable analog modules are used. Before the integration of a PROFINET node, adapt the IP address and the device as described in chapter 4.1 "Configuration of nodes (address and name)". The following system configuration is used for the description.

Figure 5-2

![Diagram of system configuration]

Procedure

1. Change to the HW Config of your multiproject.
2. From the hardware catalog in the PROFINET IO tree, from the folder "I/O", add the “IM153-4 PN HF V4.0” to the PROFINET segment.
3. According to your configuration, assign a PROFINET IO address and a device name for the ET 200M.

NOTE

The IP address and the device name were adapted before the integration according to the configuration list. An instruction for partial configuration can be found in chapter 4.1 "Configuration of nodes (address and name)".
4. Equip the ET 200M with the respective modules, equivalent to the physical structure. In this example, the HART-capable analog input module “SM331” is on the first slot.

5. In the object properties of the module, you can make channel granular settings. In this example a 2-wire temperature measuring transducer (2DMU) with HART transmission is used. All other channels have been deactivated. In addition, the “HART Fast Mode” has been activated for an optimized loading time (uninterrupted HART command sequence).

   ![Image of module properties]

   **NOTE**

   In addition to activating the “HART Fast Mode” in the object properties of the module, the transmission mode “Activate SHC Mode” in the communication settings must also be activated by SIMATIC PDM. To do so, change into the SIMATIC Manager and open the menu item “Options > SIMATIC PDM > Settings...”.

6. Add the HART field device in the respective channel.
7. Doubleclick on the HART field device for configuration and assignment.

NOTE In a first step, the HART field device is assigned a PDM object (EDD), either manually or automatically with the button “Device identification”. In a second step, you can configure the device and store relevant tag information in the device.

8. Compile and download the modified configuration into the automation system.


The ET 200M with HART-capable modules support the transmission of up to 4 HART variables per channel. The variables to be transmitted (measured values) are configured in the respective field device and set in the object properties of the module. For example a field device can additionally transmit its electronic temperature or the measured value in another measuring unit.

NOTE When HART variables are used, another 5 byte per variable are assigned in addition to every cyclic measured value (2 input/output bytes per channel). Furthermore, acyclic HART transmissions (configuration of a field device) need longer with every additional HART variable. In this case the use of a PROFIBUS PA device offers a performant alternative with additional diagnostic possibilities.
5.3 Scenario C - Configuration of a PROFIBUS PA segment

The following instruction describes the procedure for configuring a PROFIBUS PA segment with a lower-level field device on the basis of the following system configuration.

Figure 5-3

Procedure

1. Before the integration of a PROFINET node, adapt the IP address and the device as described in chapter 4.1 “Configuration of nodes (address and name)”.  
2. Change to the HW config of your multiproject.  
3. Add the “IE/PB Link PN IO” to the PROFINET segment from the hardware catalog in the PROFINET IO tree, from the folder “Gateway”.  
4. Assign a PROFIBUS DP address according to your configuration (IE/PB link PROFIBUS DP master address) for the “IE/PB Link PN IO”. In a sample configuration the addresses from Table 5-1 were used.

NOTICE A later change of the PROFIBUS DP address for the IE/PB link is not possible via PROFINET. In that case the EI/PB link must be deleted in HW Config, must be inserted again and be connected to the PROFIBUS segment.

5. According to your configuration, assign a PROFINET IO address and a device name for the IE/PB link.
6. Add the DP/PA coupler “FDC 157-0”, which is capable of diagnostics, to the PROFIBUS segment from the hardware catalog in the PROFIBUS DP tree, from the folder “DP/PA Link”. The “FDC 157-0” behaves like a PROFIBUS PA node and supplies voltage and current values of the segment as measured values.

**NOTICE**

When a DP/DA coupler is used without a preceding DP/PA link, the transmission rate of the PROFIBUS DP segment will be limited to 45.45 kBit/s. The transmission rate for PROFIBUS PA nodes still corresponds to 31.25 kBit/s. All nodes of the DP master system must be configured with different bus addresses. The use of a combination from IE/PB link with DP/PA link and DP/PA coupler is not completely supported in SIMATIC PCS 7.

7. Change to object properties of the PROFIBUS DP master system and in the tab “Network Settings”, set the transmission rate to 45.45 kBit/s.

8. If you know the address of the other PROFIBUS PA devices, you can add the field devices as usual to the PROFIBUS segment. If you do not know an address, you have the following possibilities:

   - Carry out a configuration and assign an address in the bench environment. In this case the configuration computer is equipped with SIMATIC PDM Lifelist and a PROFIBUS CP, and is connected to a DP/PA coupler with lower-level field devices.
   - Use an “FDC 157-0” with its local device detection (Local Lifelist”) for detecting connected PROFIBUS PA field devices in the segment.

   In this context, the Lifelist of the FDC 157-0 is used.

**NOTE**

The calculation tool SIMATIC field bus Calculator support you in the calculation and design of field bus segments. You can find further information via following link: https://support.industry.siemens.com/cs/ww/en/view/53842953.

9. Doubleclick on the “FDC 157-0”.

10. In SIMATIC PDM, open “View > Local Lifelist”.

© Siemens AG 2017 All rights reserved
11. In the “Local Lifelist” assigned addresses are displayed with a checked box. The pressure measuring transducer was detected with the address 6.

12. Add the pressure measurement transducer SITRANS P DS III with the address 6 to the PROFINET segment from the hardware catalog in the PROFINET PA tree, from the folder “Sensors > Pressure > SIEMENS AG”.

13. Doubleclick on the PA field device for HART field device for configuration and assignment.

**NOTE**

In a first step, the PA field device is assigned a PDM object (EDD), either manually or automatically with the button “Device identification”. In a second step, you can configure the device and store relevant tag information in the device.

14. Compile and download the modified configuration into the automation system.

15. For the further configuration, apply the “SIMATIC Process Control System PCS 7 Compendium Part A - Configuration Guidelines” via the following link: https://support.industry.siemens.com/cs/ww/en/view/109740190.

**NOTE**

To create one or more PROFINET DB segments, you can use the internal PROFINET DP interface or communication processors (CP443-5 Extended) as an alternative to the use of the IE/PB link.
### 6进一步的注释、技巧和窍门等

#### 6.1 PROFIBUS、PROFINET和以太网在办公室环境中的比较

<table>
<thead>
<tr>
<th></th>
<th>PROFIBUS</th>
<th>PROFINET</th>
<th>Ethernet (Office network)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication</td>
<td>master-slave procedure (token passing)</td>
<td>real-time provider-consumer model (switched Ethernet)</td>
<td>real-time provider-consumer model (switched Ethernet)</td>
</tr>
<tr>
<td>Typical configurations</td>
<td>line; connected at once</td>
<td>tree or ring (MRP); point-to-point connection</td>
<td>tree or ring (MRP); point-to-point connection</td>
</tr>
<tr>
<td>Processing</td>
<td>serial</td>
<td>parallel, (serial by using switches)</td>
<td>theoretically parallel, but serial by using switches and servers</td>
</tr>
<tr>
<td>Communication load</td>
<td>the same everywhere</td>
<td>dynamic, depending on the current connection path</td>
<td>dynamic, but concentrated in the server</td>
</tr>
<tr>
<td>Reaction time</td>
<td>2 .. 250 ms almost the same everywhere, depends on the scale (extension, number of slaves, medium)</td>
<td>1 … 200 ms different for every device, depends on the connection path and the update time</td>
<td>10 ms … 30 s almost constant, depends on the distance to the server</td>
</tr>
<tr>
<td>Redundancy</td>
<td>parallel buses</td>
<td>system redundancy (and MRP)</td>
<td>only in the server and, for example, HRP in the ring</td>
</tr>
<tr>
<td>Limitation</td>
<td>not more than 125 per interface not more than 32 slaves in series (can be extended via repeater); not more than 244 Bytes per slave</td>
<td>64 IO devices in series (between the sender and the receiver); 50 IO devices per ring; not more than 250 IO devices per interface; not more than 1024 IO devices per network; possibly limited routing tables in the switch; not more than 1440 Bytes per IO device</td>
<td>almost no limitation due to routing possibly limited routing tables in the switch; up to several Kbytes per device</td>
</tr>
<tr>
<td>Transmission speed</td>
<td>up to 12 Mbit/s (typ.1.5 Mbit/s)</td>
<td>10 or 100 Mbit/s (typ.100 Mbit/s) full duplex</td>
<td>10, 100 or 1000 Mbit/s (cascaded)</td>
</tr>
</tbody>
</table>
In contrast to PROFIBUS (all actions initiated by the master) and Ethernet (all actions/requests are initiated by the clients and end at the server), in PROFINET every device communicates actively on its own accord (depending on the update time that has been configured).

So compared to Ethernet, this results in a considerably higher parallelism of the data. To make use of this advantage it is sensible to distribute the network depending on the data concentration. Devices and the respective IO controller must be positioned in a network, while the other nodes (devices and IO controller are separated with switches) to keep the data traffic local.
7 Related literature

Table 7-1

<table>
<thead>
<tr>
<th>Topic</th>
<th>Title / Link</th>
</tr>
</thead>
<tbody>
<tr>
<td>1\1. Siemens Industry Online Support</td>
<td><a href="https://support.industry.siemens.com/">https://support.industry.siemens.com/</a></td>
</tr>
<tr>
<td>1\2. Download page of this entry</td>
<td><a href="https://support.industry.siemens.com/cs/ww/en/view/72887082">https://support.industry.siemens.com/cs/ww/en/view/72887082</a></td>
</tr>
<tr>
<td>4\1. SIMATIC PCS 7 overview (link collection to FAQs, manuals, compendium, forum, application examples and multimedia)</td>
<td><a href="https://support.industry.siemens.com/cs/ww/en/view/63481413">https://support.industry.siemens.com/cs/ww/en/view/63481413</a></td>
</tr>
<tr>
<td>5\1. Configuration of FOUNDATION field bus H1 (FF) with SIMATIC PCS 7</td>
<td><a href="https://support.industry.siemens.com/cs/ww/en/view/64329637">https://support.industry.siemens.com/cs/ww/en/view/64329637</a></td>
</tr>
<tr>
<td>6\1. PROFINET System Description</td>
<td><a href="https://support.industry.siemens.com/cs/ww/en/view/19292127">https://support.industry.siemens.com/cs/ww/en/view/19292127</a></td>
</tr>
<tr>
<td>7\1. How do I receive documentations about PCS 7 V8.0 (including the PCS 7 V8.0 Manual Collection)?</td>
<td><a href="https://support.industry.siemens.com/cs/ww/en/view/59538371">https://support.industry.siemens.com/cs/ww/en/view/59538371</a></td>
</tr>
<tr>
<td>8\1. Which settings must be observed in a PROFINET RT network in combination with VLAN switches?</td>
<td><a href="https://support.industry.siemens.com/cs/ww/en/view/24947500">https://support.industry.siemens.com/cs/ww/en/view/24947500</a></td>
</tr>
<tr>
<td>9\1. Calculation and design of field bus segments with the SIMATIC field bus calculator</td>
<td><a href="https://support.industry.siemens.com/cs/ww/en/view/53842953">https://support.industry.siemens.com/cs/ww/en/view/53842953</a></td>
</tr>
<tr>
<td>10\1. PROFIBUS and PROFINET International (PI) website</td>
<td><a href="http://www.profibus.com">http://www.profibus.com</a></td>
</tr>
<tr>
<td>11\1. Application example - Process automation with the SIMATIC PCS 7 CPU 410-5H controller</td>
<td><a href="https://support.industry.siemens.com/cs/ww/en/view/96839331">https://support.industry.siemens.com/cs/ww/en/view/96839331</a></td>
</tr>
</tbody>
</table>

8 History

Table 8-1

<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>Modifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>V1.0</td>
<td>10/2013</td>
<td>First version</td>
</tr>
<tr>
<td>V1.1</td>
<td>10/2014</td>
<td>Additional PCS 7 V8.1 notes added, new Ethernet switches with MRP function added (chapter 2.2.2)</td>
</tr>
<tr>
<td>V1.2</td>
<td>09/2015</td>
<td>Layout-editing, new chapter virtual LAN and additional notes added</td>
</tr>
<tr>
<td>V1.3</td>
<td>01/2017</td>
<td>Updated for PCS 7 V8.2, screenshots and information about CPU 410-5H interface X8 added</td>
</tr>
</tbody>
</table>